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Jump to the target of a schematic diagram 
connector

Click the Ref. No. of the target connector in the red box 
around a schematic diagram connector.
•	 The screen jumps to the target connector.

•	 Page magnification stays the same as before the 
jump.

ABOUT THIS MANUAL
Read the following information before using the service manual.

What you can do with this manual

Search for a Ref. No. (phrase)
(Ctrl+Shift+F)

You can use the search function in Acrobat Reader to 
search for a Ref. No. in schematic diagrams, printed 
wiring board diagrams, block diagrams, and parts lists.

1.Press Ctrl+Shift+F on the keyboard.
•	 The Search window appears.

Ctrl

Shift

F

2.Enter the Ref. No. you want to search for in the 
Search window, and then click the Search button.
•	 A list of search results appears.

3.Click an item on the list.
• 	The screen jumps to the page for that item, and 

the search phrase is displayed.
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Using Adobe Reader (Windows version)

•	 Properties 
	 Click this button and check that the printer is set to a 

suitable paper size.
•	 Page to print 
	 Select the following checkbox.
	 "More Options" : "Current View"
•	 Page Sizing & Handling 
	 Select the following checkbox.
	 "Size" / "Size Options" : "Fit"

Add notes to this data (Sign)
The Sign function lets you add notes to the data in this 
manual.
Save the file once you have finished adding notes.

[Example using Adobe Reader X]
On the "View" menu, click "Sign".
•	 The Sign pane appears.

[Example using Adobe Reader 9]
On the "Document" menu, click "Sign". 

Magnify schematic / printed wiring board 
diagrams - 1
(Ctrl+Space, mouse operation)

Press Ctrl+Space on the keyboard and drag the 
mouse to select the area you want to view.
•	 The selected area is magnified.

Ctrl Space

0

•	 When you want to move the area shown, hold down 
Space and drag the mouse.

•	 When you want to show a full page view, press 
Ctrl+0 on the keyboard.

Print a magnified part of the manual
The Properties dialog box and functions will vary depending on your printer.

1.	Drag the mouse to magnify the part you want to print.

2.	On the "File" menu, click "Print".

3.	Configure the following settings in the Print dialog box.

4.	Click the Print button to start printing.
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Magnify schematic / printed wiring board 
diagrams - 2
(Pan & Zoom function)
The Pan & Zoom function lets you see which part of a 
magnified diagram is being shown in a separate window.

[Example using Adobe Reader X]
On the "View" menu, point to "Zoom", and then click 
"Pan & Zoom".

•	 The Pan & Zoom window appears on the screen.

[Example using Adobe Reader 9]
On the "Tools" menu, point to "Select & Zoom", and 
then click "Pan & Zoom Window".

Magnify schematic / printed wiring board 
diagrams - 3
(Loupe Tool function)
The Loupe Tool function lets you magnify a specific 
part of a diagram in a separate window.

[Example using Adobe Reader X]
On the "View" menu, point to "Zoom", and then click 
"Loupe Tool".

•	 The Loupe Tool window appears on the screen.

[Example using Adobe Reader 9]
On the "Tools" menu, point to "Select & Zoom", and 
then click "Loupe Tool Window".
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SAFETY PRECAUTIONS
The following items should be checked for continued protection of the customer and the service technician.

LEAKAGE CURRENT CHECK
Before returning the set to the customer, be sure to carry out either (1) a leakage current check or (2) a line to chassis 
resistance check. If the leakage current exceeds 0.5 milliamps, or if the resistance from chassis to either side of the 
power cord is less than 460 kohms, the set is defective. 
Be sure to test for leakage current with the AC plug in both polarities, in addition, when the set's power is in each state (on, 
off and standby mode), if applicable.

CAUTION 	� Please heed the following cautions and instructions during servicing and 
inspection.

◎◎ Heed the cautions!
Cautions which are delicate in particular for servicing 
are labeled on the cabinets, the parts and the chassis, 
etc. Be sure to heed these cautions and the cautions 
described in the handling instructions.

◎◎ Cautions concerning electric shock!
(1)	� An AC voltage is impressed on this set, so if 

you touch internal metal parts when the set is 
energized, you may get an electric shock. Avoid 
getting an electric shock, by using an isolating 
transformer and wearing gloves when servicing 
while the set is energized, or by unplugging the 
power cord when replacing parts, for example.

(2)	� There are high voltage parts inside. Handle with 
extra care when the set is energized.

◎◎ �Caution concerning disassembly and 
assembly!

Through great care is taken when parts were 
manufactured from sheet metal, there may be burrs 
on the edges of parts. The burrs could cause injury if 
fingers are moved across them in some rare cases. 
Wear gloves to protect your hands.

◎◎ Use only designated parts!
The set's parts have specific safety properties (fire 
resistance, voltage resistance, etc.). Be sure to use 
parts which have the same properties for replacement. 
The burrs have the same properties. In particular, for 
the important safety parts that are indicated by the z 
mark on schematic diagrams and parts lists, be sure to 
use the designated parts.

◎◎ �Be sure to mount parts and arrange the wires 
as they were originally placed!

For safety seasons, some parts use tapes, tubes or 
other insulating materials, and some parts are mounted 
away from the surface of printed circuit boards. 
Care is also taken with the positions of the wires by 
arranging them and using clamps to keep them away 
from heating and high voltage parts, so be sure to set 
everything back as it was originally placed.

◎◎ Make a safety check after servicing!
Check that all screws, parts and wires removed or 
disconnected when servicing have been put back in 
their original positions, check that no serviced parts 
have deteriorate the area around. Then make an 
insulation check on the external metal connectors and 
between the blades of the power plug, and otherwise 
check that safety is ensured.

(Insulation check procedure)
Unplug the power cord from the power outlet, 
disconnect the antenna, plugs, etc., and on the power. 
Using a 500V insulation resistance tester, check that 
the insulation resistance value between the inplug and 
the externally exposed metal parts (antenna terminal, 
headphones terminal, input terminal, etc.) is 1MΩ or 
greater. If it is less, the set must be inspected and 
repaired.

Many of the electric and the structural parts used in 
the set have special safety properties. In most cases 
these properties are difficult to distinguish by sight, and 
the use of replacement parts with higher ratings (rated 
power and withstand voltage) does not necessarily 
guarantee that safety performance will be preserved. 
Parts with safety properties are indicated as shown 
below on the wiring diagrams and the parts list in this 
service manual. Be sure to replace them with the parts 
which have the designated part number.

(1)	 Schematic diagrams........Indicated by the z mark.
(2)	 Parts lists........Indicated by the z mark.

The use of parts other than the 
designated parts could cause electric 
shocks, fires or other dangerous 
situations.

CAUTION 	� Concerning important safety 
parts
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NOTE FOR SCHEMATIC DIAGRAM
WARNING:
Parts indicated by the z mark have critical characteristics. Use ONLY replacement parts recommended by the manufacturer.
CAUTION:
Before returning the set to the customer, be sure to carry out either (1) a leakage current check or (2) a line to chassis resistance check. If 
the leakage current exceeds 0.5 milliamps, or if the resistance from chassis to either side of the power cord is less than 460 kohms, the set 
is defective.
WARNING:
DO NOT return the set to the customer unless the problem is identified and remedied.
NOTICE:
ALL RESISTANCE VALUES IN OHM. k=1,000 OHM / M=1,000,000 OHM
ALL CAPACITANCE VALUES ARE EXPRESSED IN MICRO FARAD, UNLESS OTHERWISE INDICATED. P INDICATES MICRO-MICRO 
FARAD. EACH VOLTAGE AND CURRENT ARE MEASURED AT NO SIGNAL INPUT CONDITION. CIRCUIT AND PARTS ARE SUBJECT 
TO CHANGE WITHOUT PRIOR NOTICE.

NOTE FOR PARTS LIST

Parts indicated by "nsp"  on this table cannot be supplied.
When ordering a part, make a clear distinction between "1" and "I" (i) to avoid mis-supplying.
A part ordered without specifying its part number can not be supplied. 

General-purpose Carbon Chip Resistors are not included are not included in the P.W.Board parts list. 
(Refer to the Schematic Diagram for those parts.)

Parts indicated by the z mark  have critical characteristics. Use ONLY replacement parts recommended by the manufacturer.

General-purpose Carbon Film Resistor in the P.W.Board parts list. (Refer to the Schematic Diagram for those parts.)
Part indicated by "★" mark is not illustrated in the exploded view.

WARNING:

1.
2.
3.
4.
5.
6.

● Resistors

RD : Carbon
RC : Composition
RS : Metal oxide film
RW: winding
RN : Metal film
RK : Metal mixture

P : Pulse-resistant type
NL : Low noise type
NB : Non-burning type
FR : Fuse-resistor
F : Lead wire forming

2B : 1/8 W
2E : 1/4 W
2H : 1/2 W
3A : 1   W
3D : 2   W
3F : 3   W
3H : 5   W

F : ±1%
G : ±2%
J : ±5%
K : ±10%
M : ±20%

Ex.: RN
Type

14K
Shape
and per-
formance

2E
Power

182
Resist-
ance

G
Allowable
error

FR
Others

* Resistance
1800ohm=1.8kohm1  8 2

Indicates number of zeros after effective number.
2-digit effective number.

1.2ohm1  R 2

2-digit effective number, decimal point indicated by R.
1-digit effective number.

: Units: ohm

● Capacitors

CE : Aluminum foil
electrolytic

CA : Aluminium solid
electrolytic

CS : Tantalum electrolytic
CQ: Film
CK : Ceramic
CC : Ceramic
CP : Oil
CM: Mica
CF : Metallized
CH : Metallized

HS : High stability type
BP : Non-polar type
HR : Ripple-resistant type
DL : For change and discharge
HF : For assuring high frequency
U : UL part
C : CSA part
W : UL-CSA part
F : Lead wire forming

0J : 6.3 V
1A : 10  V
1C : 16  V
1E : 25  V
1V : 35  V
1H : 50  V
2A : 100 V
2B : 125 V
2C : 160 V
2D : 200 V
2E : 250 V
2H : 500 V
2J : 630 V

F : ±1%
G : ±2%
J : ±5%
K : ±10%
M : ±20%
Z : ±80%

: - 20%
P : +100%
C : ±0.25pF
D : ±0.5pF
= : Others

Ex.: CE
Type

04W
Shape
and per-
formance

1H
Dielectric
strength

3R2
Capacity

M
Allowable
error

BP
Others

･ Units:μF.

2200μF2  2 2

Indicates number of zeros after effective number.
2-digit effective number.

･ Units:μF.

2.2μF2  R 2

2-digit effective number, decimal point indicated by R
1-digit effective number.

* Capacity (electrolyte only)

･ When the dielectric strength is indicated in AC,"AC" is included after the dielectric strength value.

* Capacity (except electrolyte)

･ Units:pF

2200pF=0.0022μF2  2 2

Indicates number of zeros after effective number. (More than 2)
2-digit effective number.

･ Units:pF

220pF2  2 1

2-digit effective number.
Indicates number of zeros after effective number. (0 or 1)

NOTE FOR PARTS LIST
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TECHNICAL SPECIFICATIONS
nn Power amplifier section

Rated output power : �2-channel driving (CD → SP OUT) 
80 W + 80 W (8 Ω, 20 Hz – 20 kHz, T.H.D. 0.07 %)

Dynamic power : 160 W + 160 W (4 Ω, DIN, 1 kHz, T.H.D. 0.7 %)
High frequency distortion : 0.01 % (Rated output: –3 dB), 8 Ω, 1 kHz
Output terminals : Speaker �A or B: 4 – 16 Ω 

A + B: 8 – 16 Ω
	 Suited for headphones/stereo headphones
Input Sensitivity / Input Impedance : �P. DIRECT: 0.9 V / 47 kΩ 

Amplification factor: 29 dB

nn Pre amplifier section
Equalizer amplifier output (REC OUT terminals) : 150 mV
Input sensitivity/Input impedance :

PHONO (MM): 2.5 mV/47 kΩ 
PHONO (MC): 200 μV/100 Ω
CD, TUNER, AUX, NETWORK, RECORDER-1, RECORDER-2:

135 mV / 47 kΩ (SOURCE DIRECT OFF) 
135 mV / 23 kΩ (SOURCE DIRECT ON)

RIAA Deviation : PHONO : 20 Hz – 20 kHz ±0.5 dB
Maximum Input : �PHONO (MM): 130 mV/1 kHz 

PHONO (MM): 10 mV/1 kHz
Rated Output : PRE OUT: 0.9 V (Input CD 135 mV)

nn Overall performance
S/N Ratio (A network) :

�PHONO (MM): 89 dB 
(With input terminals short-circuited, 5 mV input signal) 
�PHONO (MC): 74 dB 
(With input terminals short-circuited, 0.5 mV input signal) 
CD, TUNER, AUX, NETWORK, RECORDER-1, RECORDER-2,:

108 dB (input terminals short-circuited)
Tone control (bass) : �BASS: 100 Hz ±8 dB 

TREBLE: 10 kHz ±8 dB

nn General
Power supply : AC 230 V, 50/60 Hz
Power consumption : �360 W 

0.2 W (Standby)

z �For the purpose of improvement, the specifications and design are 
subject to change without notice.

Unit : mm

39
4.
0

43
4.
2

26
1.
3

2.36
5.96

20
.0

16
1.
5

18
1.
5

434.0

344.0

61.0

45.045.0

26
.0

14
.2

Weight : 24.4 kg

DIMENSION
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WIRE ARRANGEMENT
�If wire bundles are untied or moved to perform adjustment or parts replacement etc.,be sure to rearrange them neatly as 
they were originally bundled or placed afterward.
Otherwise, incorrect arrangement can be a cause of noise generation.

Wire arrangement viewed from the top

Front Panel side
 

Back Panel side
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Wire arrangement viewed from the bottom

Front Panel side
 

Back Panel side
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DISASSEMBLY
•	 Disassemble in order of the arrow of the figure of following flow.
•	 In the case of the re-assembling, assemble it in order of the reverse of the following flow.
•	 In the case of the re-assembling, observe "attention of assembling" it.

SIDE COVER (L) SIDE COVER (R)

FRONT PANEL ASSY
Refer to "DISASSEMBLY 
4. FRONT PANEL ASSY"
and "EXPLODED VIEW"

DIRECT SW UNIT
(Ref. No. of EXPLODED VIEW : 1-2)

VOLUME UNIT
(Ref. No. of EXPLODED VIEW : 1-3)

INPUT SEL. SW UNIT
(Ref. No. of EXPLODED VIEW : 1-4)

POWER SW UNIT
(Ref. No. of EXPLODED VIEW : 1-10)

POWER LED UNIT
(Ref. No. of EXPLODED VIEW : 1-11)

TONE UNIT
(Ref. No. of EXPLODED VIEW : 3-5)

PHONE JACK UNIT
(Ref. No. of EXPLODED VIEW : 3-6)

REMOTE I/O UNIT
Refer to "EXPLODED VIEW"

REMOTE I/O UNIT
(Ref. No. of EXPLODED VIEW : 2-11

INPUT UNIT and PH/CD TER.UNIT
Refer to "DISASSEMBLY 

2. INPUT UNIT"
and PH/CD TER.UNIT"  

and "EXPLODED VIEW"
INPUT UNIT

(Ref. No. of EXPLODED VIEW : 1-1)
PH/CD TER. UNIT

(Ref. No. of EXPLODED VIEW : 3-7)

BOTTOM COVER
Refer to "DISASSEMBLY 

5. BOTTOM COVER"
and "EXPLODED VIEW"

DIODE UNIT
(Ref. No. of EXPLODED VIEW : 1-7)

UCOM UNIT
(Ref. No. of EXPLODED VIEW : 2)

CE33W==123M
Refer to "DISASSEMBLY 

8. CE33W==123M"
and "EXPLODED VIEW"

FLAT AMP UNIT and  
POWER SUPPLY UNIT

Refer to "EXPLODED VIEW"
FLAT AMP UNIT

(Ref. No. of EXPLODED VIEW : 4-1)
POWER SUPPLY UNIT

(Ref. No. of EXPLODED VIEW : 4-2)

P.AMP(R) UNIT
Refer to "DISASSEMBLY 

3. P.AMP(R) UNIT"
and "EXPLODED VIEW"

P.AMP(R) UNIT
(Ref. No. of EXPLODED VIEW : 3-2)

MULTIPLIER. UNIT
(Ref. No. of EXPLODED VIEW : 3-4)

CONNECT UNIT
Refer to "EXPLODED VIEW"

CONNECT UNIT
(Ref. No. of EXPLODED VIEW : 1-8)

AC UNIT
Refer to "EXPLODED VIEW"

AC UNIT
(Ref. No. of EXPLODED VIEW : 1-9)

REC OUT UNIT
Refer to "EXPLODED VIEW"

REC OUT UNIT
(Ref. No. of EXPLODED VIEW : 3-8)

P.AMP(L) UNIT
Refer to "DISASSEMBLY 

1. P.AMP(L) UNIT"
and "EXPLODED VIEW"

P.AMP(L) UNIT
(Ref. No. of EXPLODED VIEW : 3-1)

MULTIPLIER. UNIT
(Ref. No. of EXPLODED VIEW : 3-3)

TOP COVER
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About the photos used for "descriptions of the DISASSEMBLY" section
•	� The direction from which the photographs used herein were photographed is indicated at "Direction of photograph: ***" 

at the left of the respective photographs.
•	 Refer to the table below for a description of the direction in which the photos were taken.
•	 Photographs for which no direction is indicated were taken from above the product. 

1.	 REMOTE I/O UNIT

(1)	 Disconnect the connector wire, then remove the screw..

2.	 P.AMP(L) UNIT

(1)	 Disconnect the connector wires, then remove the screws.

The viewpoint of each photograph
(Photografy direction)

［View from above］ Front side

Direction of photograph: B

Direction of photograph: D
Direction of photograph: C

Direction of photograph: A

TOP COVER REMOTE I/O UNIT→Proceeding : 

TOP COVER P.AMP (L) UNIT→ SIDE COVER (L) →Proceeding : 
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(2)	 Remove the screws.

(3)	 Remove the screws, then remove the solder.
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3.	 INPUT UNIT and PH/CD TER.UNIT

(1)	 Disconnect the connector wires.

(2)	 Remove the screws

TOP COVER INPUT UNIT and PH/CD TER. UNIT→ SIDE COVER (R) →Proceeding : 
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4.	 P.AMP(R) UNIT

(1)	 Remove the screws.

(2)	 Disconnect the connector wires, then remove the screws. Remove the solder

TOP COVER P.AMP (R) UNIT→Proceeding : 
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5.	 FRONT PANEL ASSY

(1)	 Disconnect the connector wire.

(2)	 Remove the screws

(3)	 Remove the screws

(4)	 Loose the Cord holders, then disconnect the connector wires.

TOP COVER FRONT PANEL ASSY→ SIDE COVER (L), (R) →Proceeding : 

N0611

Direction of photograph: C

View from bottom
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(5)	 disconnect the connector wire.

Please refer to "EXPLODED VIEW" for the disassembly method of each P.W.B included in PANEL FRONT ASSY.

6.	 BOTTOM COVER

(1)	 Remove the screws.

TOP COVER BOTTOM COVER→ SIDE COVER (L), (R) →Proceeding : 
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7.	 CE33W==123M

(1)	 Cut the wire clamp bands.

(2)	 Remove the screws.

(3)	 Remove the screws.

TOP COVER BOTTOM COVER→ SIDE COVER (L), (R) →
CE33W==123M→

Proceeding : 

Direction of photograph: D

cut
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IDLING ADJUSTMENT

Setup
1.	� Lay the unit at an ordinary position away from a direct current from an air condition or fan. Do the adjustment at a 

temperature between 15°C (59°F) and 30°C (86°F).
2.	 Set control as follows.

	 POWER SWITCH	 → OFF (j)
	 VOLUME CONTROL	 → �Fully counterclockwise in the minimum position(c). 

(Main Volume and Semifixed resistors [R581, R582])
	 SPEAKER Terminals	 → Open: do not connect the speakers, dummy load etc.

Adjustment
(1)	� Remove top cover. And then connect DC Voltmeter to test points of 8U-110133-1 (Lch) and 8U-110133-2 (Rch) 

Power Amp Printing Wiring Board.
(2)	� Connect power cord to AC wall outlet, and turn POWER switch "ON" (h). Within 10 seconds turn R581 (Lch) and 

R582 (Rch) clockwise so that the DC Voltmeter reads 2 ±0.5mV.
(3)	 Then after 2 minutes warmup adjust R581 and R582 so that the DC Voltmeter reads 6 ±0.5mV.

IDLING CURRENT
Setup
1. Lay the unit at an ordinary position away from a direct current from an air condition or fan. Do the adjustment at a

temperature between 15°C (59°F) and 30°C (86°F).
2. Set control as follows.

POWER SWITCH  OFF ( ).
VOLUME CONTROL  Fully counterclockwise in the minimum position (  ).

    (Main Volume and Semifixed resistors [VR501, VR502])
SPEAKER Terminals  Open: do not connect the speakers, dummy load etc.

Adjustment
1. Remove top cover. And then connect DC Voltmeter to test points of 1U-3708-1 (Lch) and 1U-3708-2 (Rch) Power Amp

Printing Wiring Board.
2. Connect power cord to AC wall outlet, and turn POWER switch "ON" ( ). Within 10 seconds turn VR501 (Lch) and

VR502 (Rch) clockwise so that the DC Voltmeter reads 12 ±5mV.
3. Then after 2 minutes warmup adjust VR501 and VR502 so that the DC Voltmeter reads 12±5mV. 
4. And after 10 minutes warmup adjust VR501 and VR502 so that the DC Voltmeter reads 12±5mV. 

DC Voltmeter

Main Volume

8U-110133-2
Power Amp P.W.B. (R)

R582

8U-110133 -1
Power Amp P.W.B. (L)

R581

Power
Trans

Power
Trans
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TROUBLE SHOOTING
1.	 The power can not be turned on. (Power indication LED does not light.）

2.2.

2.3.

Check the insertion of the 8U-110132-6 AC UNIT.

Set remains in standby mode with power indicato 
LED lit red.

Check the insertion of the 8U-110132-2 UCOM 
UNIT.

Power indicator LED remains flashing red and 
muting mode is not canceled (protection mode is 
set).

Set operates, but then power indicator LED 
flashes red (protection mode is set).

Check each connector.

Check whether power is being supplied to the 
coil of the standby transformer (T101).

Check the power amplifier output's offset voltage.

Check the power amplifier output's offset voltage.

Power not supplied.

Offset voltage output is 1V 
or greater.

Offset voltage output is 1V 
or greater.

The connectors are 
inserted completely.

Broken wire in standby 
transformer (T101).

Damaged power amplifier 
circuit.

Damaged power amplifier 
circuit.

Malfunction of, U601 or 
S101.

Power supplied.

No offset voltage is output.

No offset voltage is output.

Malfunction of D101-106, 
C105 or C106.

Damaged temperature 
detection circuit or 
protection circuit.

Check the bias current.

2.	 The power turned on, but a sound does not output normally. (Both channels)
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2.4.

Power indicator LED is lit normally (green or 
orange). Check each connector.

Check each connector.

Check the voltage of each
department.

Check the vol tage of  each 
department.

Check the operation of the 
switching relay and speaker 
relay.

Check the operation of the 
switching relay and speaker 
relay.

Check the Signal line.

Check the Signal line.

3.	 The power turned on, but a sound does output normally. (Single channel)

Power indicator LED is lit normally (green or 
orange).
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BLOCK AND LEVEL DIAGRAM

AUX

NETWORK
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WIRING DIAGRAM
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鉛フリー半田
半田付けには、鉛フリー半田 (Sn-Ag-Cu) を使用してください。

Lead-free Solder
When soldering, use the Lead-free Solder (Sn-Ag-Cu).

PRINTED WIRING BOARDS
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鉛フリー半田
半田付けには、鉛フリー半田 (Sn-Ag-Cu) を使用してください。

Lead-free Solder
When soldering, use the Lead-free Solder (Sn-Ag-Cu).
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鉛フリー半田
半田付けには、鉛フリー半田 (Sn-Ag-Cu) を使用してください。

Lead-free Solder
When soldering, use the Lead-free Solder (Sn-Ag-Cu).
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Lead-free Solder
When soldering, use the Lead-free Solder (Sn-Ag-Cu).
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半田付けには、鉛フリー半田 (Sn-Ag-Cu) を使用してください。

Lead-free Solder
When soldering, use the Lead-free Solder (Sn-Ag-Cu).
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PARTS LIST OF EXPLODED VIEW
zParts indicated by "nsp" on this table cannot be supplied.
z�P.W.B. ASS'Y indicated by "nsp" on this table cannot be supplied. When repairing the P.W.B. ASS'Y, check the board parts list and order 

replacement parts.
zParts indicated by the " ★ " mark are not illustrated in the exploded view.
zThe parts listed below are only for maintenance. Therefore they might differ from the parts used in the unit in appearances or dimensions.

Note:	 The symbols in the column "Remarks" indicate the following destinations.
E3 : U.S.A. & Canada model 	 E2 : Europe model	 EA : Australia model
E1C : China model	 CIE3 : U.S.A. & Canada model
BK : Black model	 SP : Premium Silver model

Ref. No. Part No. Part Name Remarks Q'ty New

1 nsp INPUT P.W.B. ASSY 1 *

1-1 nsp EQ/INPUT UNIT

1-2 nsp U-COM UNIT

1-3 nsp VOLUME UNIT

1-4 nsp FUNCTION SW. UNIT

1-5 nsp CONNECT UNIT

z 1-6 nsp AC UNIT

2 nsp POWER AMP UNIT P.W.B. ASSY 1 *

2-1 nsp POWER AMP (L) UNIT

2-2 nsp POWER AMP (R) UNIT

2-3 nsp MULTIPLYER L UNIT

2-4 nsp MULTIPLYER R UNIT

z 2-5 nsp POWER SW. UNIT

2-6 nsp TONE UNIT

2-7 nsp DIODE UNIT

2-8 nsp POWER LED UNIT

2-9 nsp PHONO/CD TERMINAL UNIT

2-10 nsp REC./PRE OUT UNIT

2-11 nsp REMOTE I/O UNIT

2-12 nsp DIRECT SW. UNIT

2-13 nsp PHONE JACK UNIT

3 nsp FLAT AMP UNIT P.W.B. ASSY 1 *

3-1 nsp FLAT AMP UNIT

3-2 nsp POWER SUPPLY UNIT

5 nsp FRONT CHASSIS 1

6 nsp BUSH 1

7 nsp FLEXIBLE BUSH 2

8 nsp SHIELD PLATE 1

9 nsp BUSH 1

10 nsp TRANS CHASSIS 1

11 nsp BUSH 4

11 nsp BUSH 1

12 nsp BUSH 1

13 40631008207AD BACK PANEL 1 *

14 nsp 4P TERMINAL ASSY 2

15 nsp WIRE CLAMPER 22

16 00D4411795007 PLATE (T/C) 1

17 nsp TERMINAL ASS 1

18 nsp PWB BRACKET 2

19 nsp LOCKING CARD SPACER 3

20 nsp RUBBER PAD 1

21 nsp SP WASHER 3

Ref. No. Part No. Part Name Remarks Q'ty New

22 nsp SHIELD PLATE 1

23 nsp P C B HOLDER 4

24 nsp CARD SPACER (L=8) 2

25 nsp CARD SPACER (L=6) 5

26 nsp PWB BRACKET (A) 1

27 nsp BUSH 12

z 28 00D2033996008 AC INLET (2P) 1

29 nsp BOTTOM COVER 1

30 40751002800AD BMC FOOT (H20) ASSY 4 *

31 nsp TRANS PLATE 1

32 nsp TRANS PLATE 1

33 nsp C.PLATE 1

34 nsp BUTYL SHEET 2

35 nsp DAMP SHEET(A) 2

z 36 10101016500AD POWER TRANS E2 2 *

37 nsp WASHER 12

38 nsp CE33W==123M 2

39 nsp C.HOLDER 1

40 nsp SPACER 1

41 nsp COMMON PLATE 1

43 nsp POWER RADIATOR (R) 1

44 nsp ARM CUSHION 6

46 nsp INSULATING SHEET 4

47 nsp RADIATOR BRACKET (R) 2

48 nsp RADIATOR BRACKET (F) 2

49 nsp PLATE (RD) 2

50 nsp SCREW POST 8

51 nsp POWER RADIATOR (L) 1

52 nsp PROTECT SHEET 1

53 nsp CARD SPACER (L=20) 1

54 nsp P.W. SPACER 8

55 9S4021027300D FRONT PANEL SUB ASSY JP 1 * s

55A nsp FRONT PANEL 1

55B nsp DENON BADGE 1

55C nsp LENS 1

55D nsp LENS 1

55E nsp KNOB GUIDE(L) 1

55F nsp KNOB GUIDE (R) 1

55G nsp REMOCON WINDOW 1

55H nsp FILTER 1

56 411010095100D PUSH KNOB ASSY 2

57 nsp PLATE (M) 1

58 nsp CORD HOLDER (L50) 4

59 nsp PLATE(F) 1

61 00D1139303130 POWER KNOB ASSY 1

62 00D1120780144 KNOB (M) ASSY 1

63 00D1120966007 KNOB(F) ASSY 1

64 00D1120796125 KNOB(MARU) ASSY 3

65 404410035007D SIDE COVER ASSY 1

65A nsp SIDE COVER (L) 1

65B nsp SIDE COVER (R) 1

67 nsp SCREW BRACKET 2

68 40301003302AD TOP COVER 1 *

69 nsp SHORT PIN 2
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Ref. No. Part No. Part Name Remarks Q'ty New

71 nsp TRANS LABEL(E) 2

72 nsp HIMELON SHEET 4

73 00D4411945019 PLATE (T/C) 4

74 nsp UL TUBE (11.1) BK 1

★ 75 nsp SHIELD PLATE 1

★ 76 nsp FL SPACER 1

★ 77 nsp RUBBER SHEET 5X10XT50.5 1

★ 78 nsp INSPECTED LABEL 1

80 nsp CU PLATE 2

★ 81 nsp FERRITE CORE GTFC-25-15-12 1

★ 82 nsp CHUKOH TAPE -

★ 83 nsp CHUKOH TAPE -

★ 84 nsp NITOFLON TAPE(W25) -

★ 85 nsp BUTYL TAPE(W50 T2) -

★ 86 nsp NITOFLON TAPE(W50) -

★ 87 nsp BUTYL TAPE (W=25) -

★ 88 nsp BUTYL TAPE(W25 T2) -

89 nsp CORD HOLDER (L76) 1

★ 90 nsp PUSH RIVET 8

★ 91 nsp LABEL (HOT SURFACE CAUTION) 1

★ 92 nsp BUTYL TAPE (W=15) -

★ 93 nsp NITOFLON TAPE(W15) -

★ 94 133050075527S CQ93M2E102J(LP) C563-C570 8

SCREWS
101 nsp 3X8 CBTS(B)-B 57

102 nsp 3X6 CBTS (S)-B 23

103 nsp 4X8 CBTS (S)-B 13

104 nsp 3X8 CUP SCREW 13

105 nsp 3X14 CBTS (P)-Z 8

106 nsp 3X10 CBTS (P)-B 6

107 nsp FIXING SCREW 8

108 nsp 3X20 CBTS (S)-Z 4

109 nsp 3X8 CFTS (S)-B 2

110 nsp 3X16 CPTS(B) SW W 6

111 nsp 4X16 CBS 1

112 nsp 4N 1

113 nsp 4X65 CBS 4

114 nsp 3X6 CPS (SW.W)  ZNP 31

115 nsp 3X8 CBTS (P)-Z 17

116 0RD4737520011 2.6X10 CFTS(P) 4

117 nsp 3X8 CFTS (S)-Z 4

118 nsp SPECIAL SCREW 16

119 nsp 4X10 CBTS (S)-B 8

120 0RD4770276005 EARTH SCREW 2

121 nsp 3X8 CPS (SW.W)BK 1

WIRE
★ 301 nsp 1P CONT.ASSY 1

★ 302 nsp 1P CONT.ASSY 1

★ 303 nsp 1P CONT.ASSY 1

★ 304 nsp 1P CONTACT ASS 2

★ 305 nsp 3P EH-EH CORD CN031 1

★ 306 nsp 3P EH-EH CORD CN037 1

★ 307 nsp 3P EH-EH CON.CORD CN032 1

Ref. No. Part No. Part Name Remarks Q'ty New

★ 308 nsp 4P EH-EH CON CORD CN041 1

★ 309 nsp 5P EH-EH CON.CORD CN054 1

★ 310 nsp 5P EH-EH CON CORD CN055 1

★ 311 nsp 5P EH-EH CON CORD CN056 1

★ 312 nsp 5P EH-EH CON CORD CN057 1

★ 313 nsp 5P EH-EH CON CORD CN051 1

★ 314 nsp 6P EH-EH CON.CORD CN061 1

★ 315 nsp 6P EH-EH SHIELD CN063 1

★ 316 nsp 6P EH-EH SHIELD CN064 1

★ 317 nsp 6P EH-EH SHIELD CN066 1

★ 318 nsp 5P VH-VH CON CORD CN052 1

★ 319 nsp 3P 250mm PH-PH CN035 1

★ 320 nsp 5P 300mm PH - PH CN053 1

★ 321 nsp 6P 125mm PH - PH CN067 1

★ 322 nsp 6P 300mm PH - PH CN062 1

★ 323 nsp 6P 125mm PH - PH CN065 1

★ 324 nsp 12P 300mm PH-PH CN121 1

★ 325 nsp 13P 250mm PH - PH CN131 1

★ 326 nsp 15P 400mm PH - PH CN151 1

★ 327 nsp 3P 300mm PH-PH SHIELD CN036 1

★ 328 nsp 1P CON. ASSY 1

★ 329 nsp 1P CON. ASSY 1

★ 330 nsp 2P CON. ASSY 1

★ 331 nsp 2P CON. ASSY 1

★ 332 nsp 2P CON. ASSY 1

★ 333 nsp 2P CON. ASSY 1

★ 334 nsp 3P VH CON.CORD 1

★ 335 nsp 3P VH-VH CON CORD 1
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PACKING VIEW

PARTS LIST OF PACKING & ACCESSORIES
zParts indicated by "nsp" on this table cannot be supplied.
zThe parts listed below are only for maintenance, might differ from the parts used in the unit in appearances or dimensions.

Note:	 The symbols in the column "Remarks" indicate the following destinations.
E3 : U.S.A. & Canada model 	 E2 : Europe model	 EA : Australia model
E1C : China model	 CIE3 : U.S.A. & Canada model
BK : Black model	 SP : Premium Silver model

Ref. No. Part No. Part Name Remarks Q'ty New
SEMICONDUCTORS GROUP

201 53121010703AD CARTON CASE 1 

202 nsp CABINET SHEET 1 

203 53361005412AD CUSHION ASSY 1 

204 535510005008D ENVELOPE (ZIPPER A4) 1 

★ 54311021401AD SAFETY INSTRUCTIONS(E2) E2 1 

★ 54311019800AD INSERTION SHEET 1 

★ 54111096400AD SAFETY INSTRUCTIONS(E2) 1 

z 205 00MZC01803080 # 2P AC CORD 10A 250V CLASS2 E2 1 

★ 35201020000AD INST. MANUAL (E2 CD-ROM) E2 1 

206 54111096800AD INST. MANUAL (E2) E2 1 

207 nsp S.S.LIST(EX) 1 

208 30701012000AD RC-1179 1 

209 nsp BATTERY (R03X2) EASTPOWER 1 

210 nsp CONTROL LABEL SUB ASSY 1 

212 nsp COLOR LABEL 2 

206 207 208 209

202

205204

203

203

203

203

211

212

211

210

FRONT

201

212
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SEMICONDUCTORS
Only major semiconductors are shown, general semiconductors etc. are omitted from list. 
The semiconductors which described a detailed drawing in a schematic diagram are omitted from list.

1.	 IC's
TMP86FH47BUG (U601)

TMP86FH47BUG Terminal Functions
Pin No. Port Name I/O Function

1 VSS to GND

2 XIN x'tal (8MHz)

3 XOUT x'tal (8MHz)

4 TEST I to VSS/VDD

5 VDD to VDD

6 P21 XTIN O LED R

7 P22 XTOUT O LED G

8 RESET I reset

9 P20 INT5 STOP I Stop mode cancellation

10 P00 INT0 I ASO protector

11 P01 PDO4/PWM4PPG4 TC4 O P direct output

12 P02 RXD I RXD(program)

13 P03 TXD O TXD(program)

14 P04 SO O analog sw data (not use)

15 P05 SI O analog sw strobe (not use)

16 P06 SCK O analog sw clock (not use)

17 P07 INT4 O source direct output

18 P17 I P direct input

19 P16 I source direct input

20 P15 INT3 O ac power relay
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21 P14 PPG O volume up

22 P13 DVO O volume down

23 P12 INT2 TC1 I remocon input

24 P11 INT1 I Power off (power failure)

25 P10 PDO3/PWM3 TC3 O timer reset

26 P30 AIN0 AI Model switch 

27 P31 AIN1 AI sp output A/B (not use)

28 P32 AIN2 AI rec out selector (not use)

29 P33 AIN3 AI function A

30 P34 AIN4 STOP2 O muting

31 P35 AIN5 STOP3 O sp output A (not use)

32 P36 AIN6 STOP4 O NETWORK LED/relay drive

33 P37 AIN7 STOP5 I THERMAL/DC protector

34 VAREF to VDD

35 AVDD to VDD

36 AVSS to VSS

37 P40 O Phono LED/relay drive

38 P41 O CD LED/relay drive

39 P42 O Tuner LED/relay drive

40 P43 O AUX LED/relay drive

41 P44 O Recorder1 LED/relay drive

42 P45 O Recorder2 LED/relay drive

43 P46 I SIG. Timer

44 P47 I SIG. Det (not use)
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LB1930MC (U602)

NJU7181RB1 (U303, U304)

No. Symbol Function
1 IN AC Input
2 AMP_OUT Amplifier Output
3 TRIN External Trigger Input
4 GND Ground
5 CAP_D Delay Time Capacitor
6 RES_D Delay Time Resister
7 OUT DC Output
8 V+ Supply Voltage

Block Diagram and Sample Application Circuit 

VCC

IN1

IN2

S-GND

OUT1

OUT2

P-GND

3
60kΩ

80
kΩ

4
60kΩ

80
kΩ

9

7

1

5 6

M
CPU

C
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tro
l b

lo
ck

C1=1µF
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PARTS LIST OF P.C.B. UNIT
zParts indicated by "nsp" on this table cannot be supplied.
zThe parts listed below are only for maintenance, might differ from the parts used in the unit in appearances or dimensions.

Note:	 The symbols in the column "Remarks" indicate the following destinations.
E3 : U.S.A. & Canada model 	 E2 : Europe model	 EA : Australia model
E1C : China model	 CIE3 : U.S.A. & Canada model
BK : Black model	 SP : Premium Silver model

8U-110132 INPUT P.W.B. UNIT ASS'Y 
Ref. No. Part No. Part Name Remarks Q'ty New

SEMICONDUCTORS GROUP
z D0101-0106 00MHD20002711 1A3 1A/200V 1 

D0121 20105001130AS 1SS133(HOMI) 1 
D0301-0309 20105001130AS 1SS133(HOMI) 1 
D0601-0605 00D2760794900 KDS160-RTK/P 1 

z D0606-0612 00MHD20002711 1A3 1A/200V 1 
D0613 00D2760794900 KDS160-RTK/P 1 

z D0617,0618 00MHD20055101 !SHOTTKY 11EQS10 1A 100V 1 
z D0619 00MHD20002711 1A3 1A/200V 1 

D0620-0627 00D2760794900 KDS160-RTK/P 1 
D0652 00D2760798948 UDZS8.2B-TE17 1 
D0653 00D2760683943 UDZS3.6B-TE17 1 
D0701,0702 20105001130AS 1SS133(HOMI) 1 
D0901-0912 00D2760794900 KDS160-RTK/P 1 
D0951-0957 00D3939658915 SEL2915A-TP6 1 
Q0601-0611 00D2690192902 KRC102S-RTK/P (10K-10K) 1 
Q0612,0613 00D2690088906 DTC114TKT96          +C 1 
Q0614,0615 00D2690192902 KRC102S-RTK/P (10K-10K) 1 
Q0616,0617 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
Q0618 00MHT700241B0 KTB631K PNP TRANSISTOR RANK=Y 1 
Q0619,0620 00D2690088906 DTC114TKT96          +C 1 
Q0621 00D2690192902 KRC102S-RTK/P (10K-10K) 1 
Q0622 00MHX300012AY 2SC4081 (Q R) 2SC4116 (Y GR) 1 
Q0623,0624 00D2690192902 KRC102S-RTK/P (10K-10K) 1 
Q0625 00MHX300012AY 2SC4081 (Q R) 2SC4116 (Y GR) 1 
Q0626-0629 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
Q0630 00D2690192902 KRC102S-RTK/P (10K-10K) 1 
Q0631 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
Q0632-0635 00MHX300012AY 2SC4081 (Q R) 2SC4116 (Y GR) 1 
Q0636 00D2710260905 2SA1036KT146(S/R)    +C 1 
Q0637,0638 00MHX300012AY 2SC4081 (Q R) 2SC4116 (Y GR) 1 
Q0639 00D2740195901 2SD2114KT196         +C 1 
Q0640 00D2690066902 DTC323TKT96          +C 1 
Q0641 00MHX300012AY 2SC4081 (Q R) 2SC4116 (Y GR) 1 
Q0642 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
Q0701-0706 22255001850AS 2SK2145GR/BL(5LDMH.F) 1 *
Q0901,0902 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
U0301,0302 00D2631289900 AZ4580MTR-E1 1 
U0303,0304 23501005400AS NJU7181RB1-TE1 1 *
U0601 8R2481014700D PMA2000RE/PMA2020AE ROM ASSY 1 
U0602 23501005500AS LB1930MC 1 *
U0603 00D2631242905 NJM2831F33 1 
U0604 00D2630793002 NJM7806FA(S) 1 
U0605 00D2630801004 NJM7812FA(S) 1 
U0701 00D2623555901 SA5532ADR 1 

RESISTORS GROUP
R0303-0312 00D2412473980 RD14B2E334JT(AMRS) 1 
R0351 675010007006D V2720V30FB503MC 1 
R0695-0698 00D2442052960 RS14B3A221JNBST(S) 1 
R0701-0704 00D2412467909 RD14B2E471JT(AMRS) E2, E1C 1 
R0705,0706 00D2412465943 RD14B2E101JT(AMRS) 1 
R0707,0708 00D2412471982 RD14B2E473JT(AMRS) 1 
R0709,0710 00D2412463903 RD14B2E100JT(AMRS) 1 
R0711-0714 00D2412469907 RD14B2E332JT(AMRS) 1 
R0715,0716 00D2412466926 RD14B2E221JT(AMRS) 1 
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Ref. No. Part No. Part Name Remarks Q'ty New
R0717,0718 00D2412468966 RD14B2E222JT(AMRS) 1 
R0719,0720 00D2412465927 RD14B2E820JT(AMRS) 1 
R0721,0722 00D2412467967 RD14B2E821JT(AMRS) 1 
R0723,0724 00D2412475975 RD14B2E225JT(AMRS) 1 
R0725,0726 00D2412471982 RD14B2E473JT(AMRS) 1 
R0727,0728 00D2412469923 RD14B2E392JT(AMRS) 1 
R0729,0730 00D2412463987 RD14B2E220JT(AMRS) 1 
R0731,0732 00D2412466926 RD14B2E221JT(AMRS) 1 
R0733,0734 00D2412467909 RD14B2E471JT(AMRS) 1 
R0735,0736 00D2412474921 RD14B2E474JT(AMRS) 1 
R0737,0738 00D2412479997 RD14B2E6R8JT(AMRS) 1 
R0739,0740 00D2412473906 RD14B2E154JT(AMRS) 1 

z R0741,0742 00MGG0522016X 22 OHM  +- 5%  1/6W FLAMERETERDANT 1 

CAPACITORS GROUP
C0102 00D2538029726 CK45F2EAC332MC(KX) 1 
C0103 00D2544703706 CE04W1H101MC(RFS#A) 1 
C0104 133050083511S CQ93M2A104JT(PEF) 1 
C0105 00D2544576713 CE04W1V102MC(RA3) 1 
C0106 00D2544573936 CE04W1HR47MT(RA3) 1 
C0303-0310 133050074500S CQ93M2E101J(LP) E2, E1C 1 
C0311-0319 00D2544703706 CE04W1H101MC(RFS#A) 1 
C0320 00D2544703719 CE04W1H221MC(RFS#A) 1 
C0321,0322 133050074500S CQ93M2E101J(LP) E2, E1C 1 
C0323,0324 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0325,0326 00D2544703706 CE04W1H101MC(RFS#A) 1 
C0327,0328 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0329-0336 00D2544573981 CE04W1H100MT(RA3) 1 
C0337,0338 00D2544573952 CE04W1H2R2MT(RA3) 1 
C0339,0340 133050078403S CQ93P2D100K(FAS) 1 
C0341 00D2561054001 CF93B1H105K(GSG) ) 1 
C0342 133050076599S CQ93M2E103J(LP) 1 
C0347,0348 133050074500S CQ93M2E101J(LP) 1 
C0601 00D2544573981 CE04W1H100MT(RA3) 1 
C0602 133050076599S CQ93M2E103J(LP) 1 
C0603 00D2544573981 CE04W1H100MT(RA3) 1 
C0604 133050076599S CQ93M2E103J(LP) 1 
C0605 00D2544573981 CE04W1H100MT(RA3) 1 
C0606 133050076599S CQ93M2E103J(LP) 1 
C0607,0608 133050090557S CQ93P2A104JT(PPF) 1 
C0609,0610 133050076599S CQ93M2E103J(LP) 1 
C0611 133050090557S CQ93P2A104JT(PPF) 1 
C0612 133050076599S CQ93M2E103J(LP) 1 
C0613 00D2544576700 CE04W1V222MC(RA3) 1 
C0614 133050076599S CQ93M2E103J(LP) 1 
C0615 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0616 133050076599S CQ93M2E103J(LP) 1 
C0617 00D2544774719 CE04W1E221MF(RFS#A) 1 
C0619 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0620 133050076599S CQ93M2E103J(LP) 1 
C0621 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0622 133050076599S CQ93M2E103J(LP) 1 
C0623 00D2544774719 CE04W1E221MF(RFS#A) 1 
C0624 133050076599S CQ93M2E103J(LP) 1 
C0627 00D2544573994 CE04W1H220MT(RA3) 1 
C0628 133050076599S CQ93M2E103J(LP) 1 
C0629 00D2544573952 CE04W1H2R2MT(RA3) 1 
C0630 133050076599S CQ93M2E103J(LP) 1 
C0631,0632 00D2544573981 CE04W1H100MT(RA3) 1 
C0633 00D2544578724 CE04W1C332MC(RA3) 1 
C0634 133050076599S CQ93M2E103J(LP) 1 
C0635 00D2544573952 CE04W1H2R2MT(RA3) 1 
C0636 133050076599S CQ93M2E103J(LP) 1 
C0637 00D2544573910 CE04W1HR22MT(RA3) 1 
C0638 00D2561059996 CF93A1H105JT(JL) 1 
C0639,0640 00D2544577945 CE04W1C101MT(RA3) 1 
C0642 00D2544577961 CE04W1C331MT(RA3) 1 
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Ref. No. Part No. Part Name Remarks Q'ty New
C0643 00D2544573949 CE04W1H010MT(RA3) 1 
C0644 00D2544573910 CE04W1HR22MT(RA3) 1 
C0645,0646 00D2544574906 CE04W1H330MT(RA3) 1 
C0701,0702 133050078489S CQ93P2D470K(FAS) E2, E1C 1 
C0703,0704 133050074524S CQ93M2E151J(LP) 1 
C0705,0706 133050075527S CQ93M2E102J(LP) 1 
C0707,0708 00D2544703706 CE04W1H101MC(RFS#A) 1 
C0709,0710 133050074500S CQ93M2E101J(LP) E2, E1C 1 
C0711,0712 133050076537S CQ93M2E332J(LP) 1 
C0713,0714 00D2544703706 CE04W1H101MC(RFS#A) 1 
C0715,0716 00D2544702956 CE04W1H100MT(RFS#A) 1 
C0717,0718 133050075534S CQ93M2E122J(LP) 1 
C0719,0720 13305014120AS CQ93P2A683JC(FNS) 1 *
C0721,0722 13305014020AS CQ93P2A183JC(FNS) 1 *
C0723,0724 133050075527S CQ93M2E102J(LP) 1 
C0727,0728 133050076599S CQ93M2E103J(LP) 1 
C0731,0732 00D2544774719 CE04W1E221MF(RFS#A) 1 
C0901 133050076599S CQ93M2E103J(LP) 1 
R0313,0314 00D2544573952 CE04W1H2R2MT(RA3) 1 

OTHERS PARTS GROUP
B0801-0807 nsp M3 SCREW TERMINAL 1 
B0810 nsp 8P EH-SCN CONN.CORD 1 

z F0101 00D2061096051 FUSE(218)T4AL250V E2, E1C 1 
z F0101 00D2061035096 FUSE 10.0A JP 1 
z F0102,0103 00D2061092026 FUSE 25RF 1.0A F002 1 
z F0108 00D2061015032 FUSE (2.5A) JP 1 
z F0109 00D2061015032 FUSE (2.5A) JP 1 

H1011,1012 nsp FUSE  CLIP(TAPE) 1 
H1081,1082 nsp FUSE  CLIP(TAPE) JP 1 
H1091,1092 nsp FUSE  CLIP(TAPE) JP 1 
K0303 643810029001S RCA PIN JACK 2P AU MSP-242V3-12 GILT LF 1 
K0304,0305 643810028008S RCA PIN JACK 4P AU MSP-244V4-17 GILT LF 1 
L0701-0704 00D2359003002 FTZ CHOKE COIL E2, E1C 1 
N0210 nsp CONNECTOR 2P   B3P-VH 1 
N0220 nsp CONNECTOR 2P   B3P-VH 1 
N0230 nsp CONNECTOR 2P   B3P-VH 1 
N0240 nsp CONNECTOR 2P   B3P-VH 1 
N0311 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0321 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0330 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0340 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0350 nsp B3B-PH-K-S (LF)(SN) 1 
N0360 nsp B3B-PH-K-S (LF)(SN) 1 
N0371 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0410,0411 nsp B4B-EH-TS (LF)(SN) 4P RADIAL TAPING 1 
N0510,0511 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0530 nsp B5B-PH-K-S (LF)(SN) 1 
N0540 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0570 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0611 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0620 nsp B6B-PH-K-S (LF)(SN) 1 
N0631 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0641 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0661 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0670 nsp B6B-PH-K-S (LF)(SN) 1 
N0690 nsp B6B-PH-K-S (LF)(SN) 1 

z N0701 641050009007D AC OUTLET JP 1 
N1210 nsp B12B-PH-K-S (LF)(SN) 1 
N1310 nsp B13B-PH-K-S (LF)(SN) 1 
N1311 nsp S13B-PH-K-S (LF)(SN) 1 
N1510,1511 nsp B15B-PH-K-S (LF)(SN) 1 

z S0101 00D2140241002 RELAY DL1SU TV-8 1 
S0301-0309 00D2140127003 RELAY(RY-12W) 1 
S0601 00D2140127003 RELAY(RY-12W) 1 
S0701 665010011008D 1P PUSH SWITCH(4-2) 1 
S0901 00D2120407002 ROTALY SW.(SRRM-12) 1 
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z T0101 10101016700AD STANDBY TRANS E2 E2, E1C 1 *
z T0101 10101016600AD STANDBY TRANS JP JP 1 *

X0601 00MFQ08004061 CSTS MG 8MHZ TAPING(15PF) 1 
Z0101 nsp M3 SCREW TERMINAL 1 
Z0601 nsp STYLE PIN 1 
Z0603 nsp STYLE PIN 1 
Z0702 nsp VINYL WIRE 1 
Z0703 nsp VINYL WIRE 1 
Z0902 nsp STYLE PIN 1 



45

8U-110133 POWER AMP P.W.B. UNIT ASS'Y 

Note:	 The symbols in the column "Remarks" indicate the following destinations.
E3 : U.S.A. & Canada model 	 E2 : Europe model	 EA : Australia model
E1C : China model	 CIE3 : U.S.A. & Canada model
BK : Black model	 SP : Premium Silver model

Ref. No. Part No. Part Name Remarks Q'ty New
SEMICONDUCTORS GROUP

D0201 20105001130AS 1SS133(HOMI) 1 
D0501-0514 20105001130AS 1SS133(HOMI) 1 
D0515,0516 00D2760683930 UDZS5.1B-TE17        +C 1 
D0517-0520 00D2760798948 UDZS8.2B-TE17 1 
D0521,0522 00D2760683930 UDZS5.1B-TE17        +C 1 

z D0801 00MHE20030290 D30XBN20 SBD BRIDGE 1 
D0908 00D3939645009 SML1216W(D) 1 
D0909 00MHI20002210 SIR-34ST3F 1 
D0921 20105001130AS 1SS133(HOMI) 1 
D0951 00D2760683930 UDZS5.1B-TE17        +C 1 
Q0201-0204 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
Q0501,0502 22255001850AS 2SK2145GR/BL(5LDMH.F) 1 *
Q0503-0508 00D2730479909 2N5551S-RTK/P 1 

z Q0509-0512 21105001420AS KTA1360-Y-U/PH 1 
z Q0513,0514 21305001420AS KTC3423-Y-U/PH 1 
z Q0515,0516 00D2730445001 2SC4495 1 
z Q0517,0518 00D2730461001 KTC4370A-Y-U/P 1 
z Q0519,0520 00D2710302009 KTA1659A-Y-U/P 1 
z Q0521-Q0524 22205001700AS TK70J20D 1 *

Q0525,0526 00D2730479909 2N5551S-RTK/P 1 
Q0527,0528 00D2710318909 2N5401S-RTK/P 1 
Q0529-0532 00D2730479909 2N5551S-RTK/P 1 
Q0533,0534 00D2710318909 2N5401S-RTK/P 1 
Q0903,0904 00D2690184907 KRA102S-RTK/P (10K-10K) 1 
U0201 00D2630743007 NJM2082DD 1 
U0901 00D2623602003 GP1UE271XKVF 1 
U0902 00D3991126003 GP1UE261XKVF 1 

RESISTORS GROUP
z R0227,0228 00MGG0522016X 22 OHM  +- 5%  1/6W FLAMERETERDANT 1 

R0233,0234 00D2412469949 RD14B2E472JT(AMRS) 1 
R0251 00D2110798103 V14V20FW104K 1 
R0252 00D2110834012 V14V20FA103K 1 
R0253 00D2110834009 V14V20FA303K 1 
R0301,0302 00D2412473980 RD14B2E334JT(AMRS) 1 
R0471,0472 00D2412465943 RD14B2E101JT(AMRS) 1 
R0473,0474 00D2412475904 RD14B2E105JT(AMRS) 1 
R0479,0480 00D2412467909 RD14B2E471JT(AMRS) E2, E1C 1 
R0501,0502 121050023202S RD05A2H332FF(AMRR) 1 
R0503-0506 00D2412469949 RD14B2E472JT(AMRS) 1 
R0507,0508 00D2412467909 RD14B2E471JT(AMRS) 1 
R0509,0510 121050029200S RD05A2H105FF(AMRR) 1 
R0511,0512 00D2412468908 RD14B2E122JT(AMRS) 1 
R0513,0514 121050025246S RD05A2H333FF(AMRR) 1 
R0515,0516 121050022209S RD05A2H122FF(AMRR) 1 
R0517,0518 00D2412468924 RD14B2E152JT(AMRS) 1 
R0519-0526 00D2442694975 RS14B3A331JNBST AMRA 1 
R0529,0530 00D2442694917 RS14B3A820JNBST AMRA 1 
R0531,0532 00D2442696944 RS14B3A153JNBST AMRA 1 
R0533,0534 00D2412470909 RD14B2E822JT(AMRS) 1 
R0535,0536 00D2412467983 RD14B2E102JT(AMRS) 1 
R0537-0540 00D2442694946 RS14B3A151JNBST AMRA 1 
R0541,0542 00D2412475904 RD14B2E105JT(AMRS) 1 
R0543,0544 00D2412469907 RD14B2E332JT(AMRS) 1 

z R0546-0550 00D2442693989 RS14B3A470JNBST AMRA 1 
R0551,0552 121050025291S RD05A2H513FF(AMRR) 1 

z R0553-0556 00D2442693989 RS14B3A470JNBST AMRA 1 
z R0557,0558 00MGO05001056 0.1 OHMS +-5% 5W PBR58 1 
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R0559,0560 00D2412468966 RD14B2E222JT(AMRS) 1 
R0565,0566 00D2442693947 RS14B3A220JNBST AMRA 1 
R0567,0568 00D2412470967 RD14B2E153JT(AMRS) 1 
R0569-0572 00D2412470941 RD14B2E123JT(AMRS) 1 
R0573,0574 00D2412470925 RD14B2E103JT(AMRS) 1 
R0575,0576 00D2412471940 RD14B2E333JT(AMRS) 1 

z R0577 00D2442693989 RS14B3A470JNBST AMRA 1 
R0581,0582 16101000643AS V06QB502T 1 
R0585,0586 00D2442698007 RS14B3D100JNBF(AMRA) 1 

CAPACITORS GROUP
C0201 00D2544702956 CE04W1H100MT(RFS#A) 1 
C0203,0204 133050074500S CQ93M2E101J(LP) 1 
C0205,0206 00D2544573981 CE04W1H100MT(RA3) 1 
C0207,0208 00D2544569937 CE04W1E221MT(RA3) 1 
C0209,0210 00D2561058913 CF93A1H333JT (JL) 1 
C0211,0212 00D2544573910 CE04W1HR22MT(RA3) 1 
C0213,0214 00D2544573907 CE04W1H0R1MT(RA3) 1 
C0215,0216 00D2544573936 CE04W1HR47MT(RA3) 1 
C0217,0218 133050074500S CQ93M2E101J(LP) 1 
C0471,0472 133050074500S CQ93M2E101J(LP) 1 
C0477,0478 133050074500S CQ93M2E101J(LP) E2, E1C 1 
C0501,0502 00D2556188047 CQ09S2B101KF(PPSC) 1 
C0503,0504 133050076513S CQ93M2E222J(LP) 1 
C0505,0506 00D2544702956 CE04W1H100MT(RFS#A) 1 
C0507,0508 133050064268S CQ09S2B330KF(PPSC) 1 
C0509,0510 133050078489S CQ93P2D470K(FAS) 1 
C0517,0518 133050074555S CQ93M2E271J(LP) 1 
C0519,0520 133050074500S CQ93M2E101J(LP) 1 
C0521-0524 00D2544703719 CE04W1H221MC(RFS#A) 1 
C0525,0526 00D2556188005 CQ09S2B103JF(PPSC) 1 
C0527,0528 133050074500S CQ93M2E101J(LP) 1 
C0529-0534 133050076599S CQ93M2E103J(LP) 1 
C0537-0540 00D2544703719 CE04W1H221MC(RFS#A) 1 
C0541,0542 00D2568036006 CF93B2E104K(WAG) 1 
C0545-0548 00D2544705733 CE04W2A101MC(RFS#A) 1 
C0559-0562 00D2544702956 CE04W1H100MT(RFS#A) 1 
C0571,0572 133050076599S CQ93M2E103J(LP) 1 
C0725 00D2561054001 CF93B1H105K(GSG) ) 1 
C0808 133050076599S CQ93M2E103J(LP) 1 
C0904 133050076599S CQ93M2E103J(LP) 1 
C0905 00D2544573949 CE04W1H010MT(RA3) 1 
C0906 133050076599S CQ93M2E103J(LP) 1 
C0907 00D2544573949 CE04W1H010MT(RA3) 1 

OTHERS PARTS GROUP
B0808-0810 nsp M3 SCREW TERMINAL 1 
B0813,0814 nsp M3 SCREW TERMINAL 1 
K0301 00D2048548001 4P PIN JACK(18MM) 1 
K0306,0307 643810028008S RCA PIN JACK 4P AU MSP-244V4-17 GILT LF 1 
K0501 643010073204S PHONE JACK BOARD(9P) 1 
K0901 00D2048729008 2P MINI JACK 1 
N0011-0016 00D2050864003 M3 SCREW TERMINAL 1 
N0221 nsp CONNECTOR 2P   B3P-VH 1 
N0310 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0320 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0351 nsp B3B-PH-K-S (LF)(SN) 1 
N0361 nsp B3B-PH-K-S (LF)(SN) 1 
N0501,0502 nsp 3P NH CONNECTOR BASE 1 
N0521-0524 nsp 6P PIN HEADER(6035) 1 
N0531 nsp B5B-PH-K-S (LF)(SN) 1 
N0541 nsp S5B-EH 1 
N0550 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0560 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0610 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0621 nsp B6B-PH-K-S (LF)(SN) 1 
N0630 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
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N0640 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0650 nsp S6B-PH-K-S (LF)(SN) 1 
N0651 nsp B6B-PH-K-S (LF)(SN) 1 
N0811 nsp B8B-EH 1 
N0911-0914 nsp M3 SCREW TERMINAL 1 
N1011 nsp B10B-EH 1 
N1211 nsp B12B-PH-K-S (LF)(SN) 1 

z S0101 66105000300AS POWER SWITCH (TV-5) 1 
S0201 665010010005D 1P PUSH SWITCH(6-2) 1 
S0251 00D2140127003 RELAY(RY-12W) 1 
S0551,0552 00D2140195006 RELAY FTR-F1 1 
S0602 665010010005D 1P PUSH SWITCH(6-2) 1 
Z0003 nsp M3 SCREW TERMINAL 1 
Z0201 nsp STYLE PIN 1 
Z0203 nsp STYLE PIN 1 
Z0503,0504 252310006506S PRF18BB471QB5RB 1 
Z0901 nsp STYLE PIN 1 
Z0902 nsp SHIELD CASE FLASHER SR7005 A332 1 
Z0903 nsp STYLE PIN 1 
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8U-110134 FLAT AMP P.W.B. UNIT ASS'Y 

Note:	 The symbols in the column "Remarks" indicate the following destinations.
E3 : U.S.A. & Canada model 	 E2 : Europe model	 EA : Australia model
E1C : China model	 CIE3 : U.S.A. & Canada model
BK : Black model	 SP : Premium Silver model

Ref. No. Part No. Part Name Remarks Q'ty New
SEMICONDUCTORS GROUP

D0404,0405 00D2760683930 UDZS5.1B-TE17        +C 1 
D0406,0407 00D2760683943 UDZS3.6B-TE17 1 
D0408,0409 00D2760683930 UDZS5.1B-TE17        +C 1 
D0421-0426 20105001130AS 1SS133(HOMI) 1 
D0427,0428 00D3939674902 SLR343EC4TT32 1 
D0431-0433 20105001130AS 1SS133(HOMI) 1 

z D0821 00D2760706008 FCH20A15 1 
z D0822 00D2760707007 FRH20A15 1 

D0823-0826 00D2760683998 UDZS16B-TE17         +C 1 
D0828,0829 00D2760683998 UDZS16B-TE17         +C 1 
Q0421-0424 00D2730479909 2N5551S-RTK/P 1 
Q0425,0426 22255001850AS 2SK2145GR/BL(5LDMH.F) 1 *
Q0429,0430 00D2730479909 2N5551S-RTK/P 1 
Q0431,0432 00D2730471907 KTC3206-Y-AT/P 1 
Q0433-0436 00D2710314903 KTA1024-Y-AT/P 1 
Q0437,0438 00D2750069001 2SK215 1 
Q0439,0440 00D2750068002 2SJ78 1 
Q0451,0452 00D2690088906 DTC114TKT96          +C 1 
Q0821-0824 00D2750094908 2SK209-GR            +C 1 

z Q0825 00D2730461001 KTC4370A-Y-U/P 1 
z Q0826 00D2710302009 KTA1659A-Y-U/P 1 
z Q0827 00D2730461001 KTC4370A-Y-U/P 1 
z Q0828 00D2710302009 KTA1659A-Y-U/P 1 

RESISTORS GROUP
R0421,0422 00D2412475904 RD14B2E105JT(AMRS) 1 
R0423,0424 00D2412466926 RD14B2E221JT(AMRS) 1 
R0425,0426 00D2412471940 RD14B2E333JT(AMRS) 1 
R0427,0428 00D2412471982 RD14B2E473JT(AMRS) 1 

z R0429-0432 00D2442695929 RS14B3A102JNBST AMRA 1 
R0433,0434 00D2412466968 RD14B2E331JT(AMRS) 1 
R0435,0436 00D2412467967 RD14B2E821JT(AMRS) 1 
R0437,0438 00D2412475904 RD14B2E105JT(AMRS) 1 
R0439,0440 00D2412469965 RD14B2E562JT(AMRS) 1 
R0441,0442 00D2412467983 RD14B2E102JT(AMRS) 1 

z R0443,0444 00D2442694920 RS14B3A101JNBST AMRA 1 
R0445-0448 00D2442693989 RS14B3A470JNBST AMRA 1 
R0449,0450 00D2412474921 RD14B2E474JT(AMRS) 1 
R0451-0454 00D2442693989 RS14B3A470JNBST AMRA 1 
R0457,0458 00D2412465943 RD14B2E101JT(AMRS) 1 
R0475-0478 00D2412472965 RD14B2E104JT(AMRS) 1 
R0821-0824 00D2412467983 RD14B2E102JT(AMRS) 1 

z R0825,0826 00MGG0501016X 1 OHM  +- 5%  1/6W FLAMERETERDANT 1 

CAPACITORS GROUP
C0421,0422 00D2556188047 CQ09S2B101KF(PPSC) 1 
C0423,0424 00D2544702956 CE04W1H100MT(RFS#A) 1 
C0425,0426 133050076599S CQ93M2E103J(LP) 1 
C0427-0430 00D2544702943 CE04W1H4R7MT(RFS#A) 1 
C0431,0432 133050078472S CQ93P2D390K(FAS) 1 
C0433-0436 133050076551S CQ93M2E472J(LP) 1 
C0437,0438 00D2556188005 CQ09S2B103JF(PPSC) 1 
C0439,0440 133050076599S CQ93M2E103J(LP) 1 
C0441-0444 00D2544703706 CE04W1H101MC(RFS#A) 1 
C0451 00D2544703748 CE04W1H102MC(RFS#A) 1 
C0453 00D2544703748 CE04W1H102MC(RFS#A) 1 
C0455,0456 133050078489S CQ93P2D470K(FAS) 1 
C0461-0463 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0466 00D2544703719 CE04W1H221MC(RFS#A) 1 
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Ref. No. Part No. Part Name Remarks Q'ty New
C0473-0476 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0827,0828 133050076599S CQ93M2E103J(LP) 1 
C0829,0830 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0831,0832 00D2544703748 CE04W1H102MC(RFS#A) 1 
C0833,0834 133050076599S CQ93M2E103J(LP) 1 
C0835,0836 00D2544703777 CE04W1H470MC(RFS#A) 1 
C0837,0838 00D2544703748 CE04W1H102MC(RFS#A) 1 
C0839,0840 133050076599S CQ93M2E103J(LP) 1 
C0841-0844 00D2544703748 CE04W1H102MC(RFS#A) 1 

OTHERS PARTS GROUP
z F0821,0822 00D2061093012 FUSE 25RF 3.15A F006 1 

N0250 nsp 2P PLUG B2P3S-VH 1 
N0260 nsp 2P PLUG B2P3S-VH 1 
N0370 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1 
N0520,0521 nsp B5P-VH 1 
N0551 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0561 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0571 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1 
N0660 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1 
N0671 nsp B6B-PH-K-S (LF)(SN) 1 
S0401-0403 00D2140127003 RELAY(RY-12W) 1 
Z0801 nsp STYLE PIN 1 
Z0811 nsp M3 SCREW TERMINAL 1 
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